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1 Overview  

SightLine software has the capability of performing Non-Uniformity Correction (NUC) and Dead Pixel 
Removal (DPR), also known as bad pixel replacement. Both NUC and DPR help to improve the video 
and imaging quality from an IR camera. This function is useful for cameras that do not have this feature 
built-in from the manufacturer.  

The calibration process should be performed for every camera and lens. It may need to be done again 
in the future if quality noticeably degrades. Due to the natural drifting of the detector, there is not a 
specific timeframe for this calibration process. For best results, NUC/DPR will run on raw digital video 
output from the camera.  

SightLine software uses a nearest neighbor replacement algorithm to replace bad pixels. The software 
can replace any pixel if there is a good pixel within an offset of five pixels from a pixel defined as bad.  

1.1 Additional Support Documentation  

Additional Engineering Application Notes (EANs) can be found on the Documentation page of the 
SightLine Applications website.  

Panel Plus User Guide provides a complete overview of settings and dialog windows. It can be accessed 
from the Help menu of the Panel Plus application. 

The Interface Command and Control (IDD) describes the native communications protocol used by the 
SightLine Applications product line. The IDD is also available as a PDF download on the Software 
Downloads page. 

1.2 SightLine Software Requirements 

 IMPORTANT: Starting with 3.6.x software and above, only the 4000 and 1700 platforms will be 
supported. The 1500 and 3000 platforms will continue to be supported in 3.5.x software. Some 
features in 3.6.x and above may not be available on 1500 and 3000 platforms. 

 IMPORTANT: The Panel Plus software version should match the firmware version running on the 
board. Firmware and Panel Plus software versions are available on the Software Download page. 

1.3 Application Bit Requirements    

The functions described in this EAN require Application Bits (app bits) purchased from SightLine. App 
bits are enabled with a license file provided by SightLine at initial unit purchase or during a license 
upgrade process. License files use a hardware ID that is applicable to a specific hardware serial 
number. For questions and upgrade support contact Sales. 

Table 1: Application Bits Requirement Table  

Function  Initial Software Release Required Application Bit(s) v7 License  Notes 

NUC/DPR  
 

3.00.xx  NUC/DPR + High Bit Depth/Temp Telemetry 
0x0006 0000* 

NUC/DPR was enabled with the Blending app 
bit in 2.25.xx. 

Optional/recommended: Recording 0x0000 
0400. 

Snapshot recording for troubleshooting raw 
image capture requires the Recording app bit. 

*High Bit Depth/Temp Telemetry is a prerequisite for NUC/DPR. 

https://sightlineapplications.com/documentation/
https://sightlineapplications.com/downloads/
https://sightlineapplications.com/releases/IDD/current/
https://sightlineapplications.com/downloads/
https://sightlineapplications.com/downloads/
https://sightlineapplications.com/downloads/
mailto:sales@sightlineapplications.com
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1.4 Performance 

NUC and DPR add a latency of less than 5 milliseconds. See EAN-Performance-and-Latency for tools on 
measuring performance. 

1.5 Max Resolution 

The following table shows the max resolution for the NUC/DPR process on each OEM board. 

Table 2: Max Resolution Requirement Table 

Max Resolution 

SW Version 1500-OEM 3000-OEM 3000-OEM Rev C 1750-OEM 4000-OEM 

2.25.xx 640x512 640x512    

3.0.x 640x512 Rev B: 640x512 1280x1024  1920x1080 

3.1.x - 3.3.x 640x512 Rev B: 1280x1024 1280x1024  2560x1440 

3.6.x    1920x1440  

2 NUC and DPR Process 

The system acquires a fixed number of raw unprocessed still images from the IR camera. A set of 
images is collected at two temperatures. The first set is collected at a temperature representing the 
operational high temperature (e.g., 50°C). The second temperature represents the operational low 
temperature (e.g., 25°C). This provides a sufficient sample behavior of the camera over a range of 
temperatures that will be experienced in the field. From these images, the software then determines 
which pixels are non-operational (dead) and may need to be replaced at run time.  

Non-Uniformity Correction is performed by accumulating statistics from the collected images and 
calculating a gain and offset for each pixel in the image that will be applied at run time. The NUC and 
DPR tables are saved as files on the hardware and can be loaded at run time. Multiple tables can be 
created to accommodate different operational scenarios for a given camera. For example, a NUC/DPR 
table may be created that represents an ocean flyover, and another table for operations in the 
mountains. 

A 1-Point field NUC is an efficient way to update the offset of each pixel to improve image quality with 
less calibration hardware.  

Non-operational pixels use a distance formula to determine the replacement pixel to use. Preference is 
given to smaller distances and the max offset for both X (column) and Y (row) coordinates is 5 pixels. 

 IMPORTANT: A NUC calibration must be performed at the scene temperature range where the unit 
will be operating. The detector pixels are non-linear with scene temperature, and the NUC process 
seeks to linearize these over a small temperature range. For example, using a NUC calibration taken 
at a scene temperature of ~40°C while imaging a scene temperature at 20°C will result in poor 
image quality. In this example, applying a 1-Point NUC correction only updates the offset table and 
not the gain table. The correct procedure would be to take a new set of NUC calibrations centered 
at ~20°C. 

 

 

https://sightlineapplications.com/wp-content/uploads/EAN-Performance-and-Latency.pdf
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2.1 Requirements 

• MicroSD card installed on OEM boards. 

• 16-bit or 14-bit gray scale capability. 

• SWIR, LWIR, MWIR imaging capability. 

• Ability to output unaltered pixel values. 

• Two different uniform temperature targets. (~20°C apart). For example, a thermal black body and 
associated power supply capable of maintaining temperatures approximating expected operational 
high and low temperatures. 

3 Panel Plus Configuration Settings 

Before connecting with the Panel Plus software, the OEM board should be powered up and connected 
through: 

- a network switch or directly to the host PC (preferred) or, 

- Direct serial connection (for troubleshooting or if a network connection cannot be established). 

 See the one of the corresponding OEM startup guides for connection and video streaming 
instructions: 

• EAN-Startup Guide-1500-OEM 

• EAN-Startup Guide-1750-OEM - Supported in software versions 3.6.x and above. 

• EAN-Startup Guide-3000-OEM 

• EAN-Startup Guide-4000-OEM 

 IMPORTANT: This procedure assumes that the customer has read the OEM startup guide(s) and 
has a basic understanding of the following fundamentals:  

• Completed a functional connection between the SightLine video processing board and Panel 
Plus application 

• Familiar with Panel Plus controls 

• Successfully streamed video in Panel Plus 

 If you do not have a strong basic system setup and familiarity, we recommend reviewing the OEM 
startup guide(s) and work with our support team to establish basic connection and streaming 
fundamentals. 

3.1 Acquisition Settings 

See the camera configuration tables for supported cameras settings.  

From the main menu in Panel Plus go to Configure » Acquisition Settings. For information about 
acquisition fields in Panel Plus see EAN-Digital-Video-Configuration. 

 Save parameters and reset the board when changing parameters. Cycle system power when 
changing resolution. If video is not present, cycle system power. 

http://sightlineapplications.com/wp-content/uploads/EAN-Startup-Guide-1500-OEM.pdf
https://sightlineapplications.com/wp-content/uploads/EAN-Startup-Guide-1750-OEM.pdf
http://sightlineapplications.com/wp-content/uploads/EAN-Startup-Guide-3000-OEM.pdf
https://sightlineapplications.com/wp-content/uploads/EAN-Startup-Guide-4000-OEM.pdf
https://sightlineapplications.com/releases/IDD/current/camera_configuration.html
http://sightlineapplications.com/wp-content/uploads/EAN-Digital-Video-Configuration.pdf
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3.2 Enable Warning Types 

New in 3.2.x software. 

SightLine software communicates status messages for NUC and DPR through the User Warning dialog 
window. To enable warning message types, from the main menu in Panel Plus » View » User Warnings.  

Informational: Displays status 
messages that valid successful actions. 
Examples include:  

• Successfully loading or saving a 
NUC or DPR table. 

• All frames have been added 
successfully. 

• The number of dead pixels that 
were calculated after performing 
the dead pixel operation. 

Critical: Displays errors during any 
process type functions. Examples 
include:  

• Errors that occur during normal 
NUC and DPR processes. 

• Error saving a NUC or DPR table. 

• Error loading a NUC or DPR table. 

General:  Other non-error messages 
that convey unsuccessful actions.  

 

Figure 1: User Warning Messages 

 

3.3 Disable Stabilization 

 IMPORTANT: In the Video tab of Panel Plus, Stabilization should be set to OFF before starting the 
NUC and DPR process. 

 

Figure 2: Stabilization OFF 
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3.4 Calculate NUC Tables 

1. From the main menu in Panel Plus » Configure » NUC/DPR. 

2. Click Reset All. This will put the system in a known state for calculating NUC/DPR. 

3. Point the camera at the temperature source that is being used for operational high temperature. 

 The target plate should fill the entire field of view of the camera to provide a uniform image at this 
temperature. 

4. Set the Add Frames field to 30 (default), and then click Add. The frames will be captured within a 
few seconds.  

 

 IMPORTANT: A user warning will be displayed that indicates when frames have been added. 

5. Point the camera at an operational low temperature source.  

 The target plate should fill the entire field of view of the camera to provide a uniform image at this 
temperature. 

6. Click Add. This completes the data needed for NUC and DPR calculations. 

7. Click 2 Point NUC to perform the non-uniformity correction process.  

 

This step will automatically enable the NUC and DPR image processing. The result should be a 
grayscale image similar to the example shown in Figure 3. 

 

  Figure 3: NUC and DPR Process Resulting Grayscale Image 

 

Grayscale Image 
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8. To save the NUC table to the microSD card, enter a filename in the NUC Table Filename field and 
click Save. The .nuc extension will automatically be added to the filename. 

 

 Optional: To set the NUC table see Setting Default NUC and DPR Table. 

3.5 Dead Pixels Replacement 

To perform a dead pixel replacement, use the following steps: 

1. In the Show section, use the Gain and Offset selections to see the results of each. 

  

The image will change to black and white. Numbers are shown in the upper left corner with a 
histogram drawn over the top of it. The histogram displays the statistical values of the image 
shown in Figure 4. 

 

Figure 4: Fine Tuning Dead Pixel Replacement Parameters 

2. Use the Pixel Gain and Pixel Offset to adjust the max and min values to help fine tune the dead 
pixel replacement parameters.  

 There should be only one peak on the graph. The Mean should be near 1.00. The standard deviation 
(StdDev) can vary. The max and min values should be set to at least 4 standard deviations above 
and below the mean. This is not a fixed value and will vary depending on the application.  
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3. For the example on the left shown in Figure 4, round up the standard deviation to .06 and multiply 
by 4. This results in 124% and 76% for the max and min Pixel Gain values, respectively.  

4. For the example on the right, this can be repeated for the Pixel Offset values. The mean and the 
standard deviation appear in the upper left. Round up the standard deviation to 130.00 and 
multiply by This results in a max and min offset of 520 and -520 values, respectively.  

5. In the DPR - Dead Pixel Replacement section, click Calculate.  

 

The video may freeze or disappear briefly while the calculation happens. When the image returns, 
the dead pixels should be gone (Figure 6). If dead pixels persist adjust the parameters to a narrower 
range.  

 
 

Figure 5: NUC without DPR Figure 6: NUC with DPR 

 Also see the Dead Pixel Issues section and Appendix sections A1 and A4 for alternate solutions. 

6. To save the dead pixel table to the microSD card file system, enter a filename in the Dead Pixel 
Table Filename field and click Save.  

   

 Optional: To set the DPR table see Setting Default NUC and DPR Table. 

 IMPORTANT: Once the NUC/DPR process is completed and the system rebooted, the Dead Pixel 
map cannot be updated by loading the NUC Gain and Offset tables and changing the dead pixel 
calculation parameters. The statistics required are currently not saved in the Gain and Offset tables 
inside the NUC file. 

 IMPORTANT: Before completing the NUC/DPR process and rebooting the system, make sure to 
view the Gain, Offset and Dead Pixel maps outlined in the Debugging section.  

By using narrow constraints, it is possible to create a dead pixel map with large clusters of dead pixels 
in the corners. Since the dead pixel operation consists of replacing dead pixels with neighboring pixels, 
large clusters of dead pixels can lead to blocky imagery in the corners. 

 

 

Dead pixels 
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3.6 Test Settings 

1. Point the camera at representative real-world scene. From the main menu in Panel Plus » Configure 
» NUC/DPR. 

2. In the Show section, toggle the Apply NUC checkbox. The video should be smoother, and less 
streaked with NUC enabled. Toggle the Apply Dead checkbox. If any dead pixels are visible when 
inactive, they should look better when set to active. 

 

    

Figure 7: Without NUC/DPR Figure 8: With NUC/DPR 

Additional NUC and DPR files can be created by repeating the steps above for various lens positions, 
integration times, or other metrics for which new calibrations may be required. 

3.7 Setting Default NUC and DPR Table 

To automatically load a NUC table or dead pixel table when the system is booted up, a single NUC table 
and a single dead table can be set as default. These settings are saved in the parameter file and can be 
set or deleted using Panel Plus or command and control packets. 

3.8 Storage of NUC / Dead Table 

The filenames shown in Table 3 are specified in the NUC and DPR Panel Plus window when saving. 

When saving tables, the file extension will be appended to the end of the filename provided. SightLine 
software will treat <filename>.nuc the same as <filename> when it is entered into the NUC and DPR 
Panel Plus window. 

The NUC and DPR tables are listed in the Files on the SD section of the Record tab along with any 
associated files (e.g., screenshots). 

Table 3: NUC and DPR File Storage 

Filename Format Description 

<filename>.nuc The NUC table is stored in binary. 

<filename>.dead The dead pixel table is stored in binary. 
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4 Additional Features 

4.1 Debugging  

 For debugging purposes, the Gain, Offset, and Dead Pixel calculations can be viewed as images. 

1. To view these images, click on the corresponding radio button in the Show field to replace the live 
image feed from the camera with the calculation image of your choice. 

 

 The whiter the pixel is the larger the corresponding calculation is.  

2. When finished, click on the Live button to return to the live image feed.  

3. After calculation both the NUC and DPR are automatically active. To turn one or both off, uncheck 
the boxes. 

 

4.2 Using Multiple Calibration Tables 

For some applications more than one NUC or dead pixel calibration may be needed. To help facilitate 
this, SightLine systems have the capability of saving and loading calibration files. 

 IMPORTANT: These tables are currently saved to the microSD card. 

An FTP client can be used to review the calibration tables that are already on the system as shown in 
the example in Figure 9.  

 

Figure 9: Managing NUC and DPR Tables with FTP Client 
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4.3 1-Point NUC 

The 1-Point NUC is an efficient way to update the offset of each pixel to improve image quality with 
less calibration hardware. This calibration process updates the offset values stored in the NUC table 
currently applied to the image. To persist the 1-Point NUC calibration through subsequent restarts, 
save the NUC table.  

 This replaces the current NUC table offsets with the new adjusted table offsets.  

If the imager is pointed outside or placed in a different temperature location after performing a 2-Point 
NUC calibration and there appears to be more dead or hot pixels, perform a 1-Point (field) NUC to 
update the calibration. 

 Substituting 1-Point NUC for the 2-Point NUC calibration process is not recommended. Use it as an 
additional option if a reduction in pixel quality is noticed over time during normal camera use. 

The standard practice for this type of calibration is to close the shutter of the camera to obtain a flat 
field during designated periods, perform a 1-Point NUC, and then open the shutter. This is normally 
used in non-cooled IR cameras since the function that dictates NUC varies with time more often than 
with cooled cameras. 

 

Figure 10: 1-Point NUC Configuration 

 This can also be performed through the NucParameters (0x35) Command and Control packet 
described in the Command and Control Packets section. See Appendix section A5 for an example. 

 If performing a 1-Point NUC after performing the 2-Point NUC calibration without cycling the power 
on the SightLine board, it is important to clear the frames added. This can be done by clicking the 
Clear All button in Panel Plus. 

4.4 Shutter Flattening 

New in 3.3.x software.   

Shutter flattening is another way to update the offsets for each individual pixel when the imager has 
no way to use a flat field to perform the 1-Point NUC operation.  

To perform shutter flattening the lens should be defocused to the point where there are no 
distinguishable features in the field of view. A collection of frames is collected, averaged internally, and 
then ran through the algorithm, which removes the high frequency features providing a smoother 
image. 

This feature should only be used if the user cannot perform a 1-point NUC properly.  
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5 Command and Control Packets  

See the IDD.  

NucParameters (0x35) Set NUC and DPR parameters y=mx+b line of best fit calculated for NUC 
and DPR. 

ReadWriteNuc (0x36) Used to save or load NUC/DPR tables as well as set a table to be applied 
on startup. 

DeadPixelStats (0xA1) 

DeadPixel (0xA8) 

Statistics from DPR calibration process. 

Perform a designated mode of operation on a specified pixel. 

5.1 Manual Dead Pixel Replacement Mode 

New in 3.3.x software. 

 This feature may not function correctly if any modifications that alter the coordinate system of the 
display image, such as panning, tilting, rolling correction, or digital zooming, are being used. 

1. To enable the point-and-click manual dead pixel replacement mode click on Manual in the DPR - 
Dead Pixel Replacement section. 

 

 This opens the Manual DPR List dialog window, which will remain open and indicate that the 
Manual Dead Pixel Replacement mode is active. 

 

Figure 11: Manual DPR List Dialog Window 

 

https://sightlineapplications.com/releases/IDD/current/
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2. In the Manual DPR List window click Snap to take a still snapshot of the current camera that is 
being streamed to Panel Plus. 

 

3. Locate and click on a dead pixel. Use the Zoom and Pan/Tilt buttons in the Video tab to help click 
on them. After clicking on a pixel, it will turn to a magenta color and a row will be added to the 
table to the right showing the Row and Column of the pixel (Figure 12). 

 The Manual DPR List dialog window will populate in order of pixels that are added. As the list grows 
a scroll bar appears allowing the user to scroll through the manually added dead pixels. 

 Click Snap at any point to update the current snapshot. 

 

Figure 12: Example - Locating Dead Pixels 

4. To delete or remove any of the selected pixels (magenta pixels) from the current list click on them 
again, they will turn blue in color (Figure 13). 

5. Click Delete to remove them from the list.  

 Depending on the number of pixels selected there may be a delay in pixel removal after the Delete 
button is clicked. 

 

Figure 13: Example - Removing Dead Pixels from Current List 
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6. When finished click the Send To Board button to send the pixels listed in the table to the SightLine 
board. The current snapshot will disappear, and these pixels will be added to the current dead list.  

  

 To see the newly applied dead table, click Snap. 

 Saving the dead pixel table adds the dead pixels to the current dead table. This file can be loaded on 
future power cycles or set as default like any other dead table. 

5.2 Auto DPR 

New in 3.3.x software. 

The Auto DPR feature uses an automatic detection on a single frame to designate pixels as dead based 
on the difference between a given pixel and the area around it.  

This feature will perform better if a pixel that is designated as dead is not on a boundary between hot 
and cold in the image. 

 

Figure 14: Auto Dead Pixel Replacement 

 Due to the automatic nature of the algorithm, it is more prone to false positives. It may identify 
more pixels as being dead than there actually are. Click Manual to fine tune the process. 

5.3  Modifying Dead Pixel Replacement Table 

It is possible that the NUC and DPR process will not replace every dead pixel. If this occurs, try using 
the command and control packet DeadPixel(0xA8) to add additional dead pixels to the dead pixel 
replacement table. 

To remove a dead pixel from an existing dead replacement table, use mode 0x01, the row of the pixel, 
and the column of the pixel you would like to remove from the table. 

 IMPORTANT: Do not remove dead pixels that have been determined dead through the automatic 
NUC and DPR process. Only remove dead pixels that were added manually to the table. 

For advanced users SightLine has provided the format for both the NUC and DPR tables in Appendix 
sections A2 and A3 for manual entry and modification.  

 IMPORTANT: Due to the complexity of this process, technical support for this method is limited.  
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5.4  Dynamic Dead Filter 

New in 3.3.x software.  

The dynamic dead filter is an algorithm that is applied on a per frame basis that compares each 
individual pixel to the surrounding pixels. If the pixel under question is outside the given threshold the 
pixel will be replaced based on the mode selected. 

In the min max mode, the dead filter compares each pixel to the min and the max of a 3x3 area around 
the pixel. If the value is higher than the max + threshold, or lower than min – threshold, the pixel is 
replaced. 

In the near far mode, the dead filter compares each pixel to the to the min and max of the nearest 
pixels in a 3x3 window (row ± 1 and col ± 1) and the min and max of the furthest pixels in a 3x3 window 
(i.e., the corners) and a threshold. If a pixel is determined as dead, it replaces that pixel with a median 
of the nearest pixels. 

5.5  3D Noise Stats 

New in 3.4.x software. 

Calculating the noise metrics can help evaluate the effectiveness of the NUC/DPR process. The 
calculations are based on Finite Sampling Corrected 3D Noise with Confidence Intervals, and ImageJ 
plugin Calculate_3D_Noise.java, though the calculations have some important differences from those 
in the plugin.  

 IMPORTANT: The SightLine calculation results may not match those calculated by the ImageJ 
plugin. The ImageJ plugin makes modifications to the data cube as it goes through its sequence of 
calculations. The SightLine calculation acts on an unmodified version of the sampled data. 

To calculate the noise metrics:  

1. Perform NUC/DPR calibration process. 

2. From the Panel Plus main menu go to » Configure » NUC/DPR to open the NUC/DPR dialog window. 

 Keep the NUC/DPR dialog window open during this process. 

3. Click the Noise Stats from the DPR - Dead Pixel Replacement section to open the Noise Stats dialog 
window.  

 

4. Is the NUC/DPR dialog window. Set the number of frames to use in the calculation in the Add 
Frames field. 

  

https://opg.optica.org/ao/fulltext.cfm?uri=ao-54-15-4907&id=318871
https://imagej.nih.gov/ij/plugins/download/Calculate_3D_Noise.java
https://imagej.nih.gov/ij/plugins/download/Calculate_3D_Noise.java
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5. To calculate with raw images without NUC or DPR make sure the corresponding boxes in the 
NUC/DPR window are unchecked. 

 

6. Click the Calculate button in the Noise Stats window. The Update button will turn red. When 
calculations are complete, the following user warning will display: Warning: NUC: Noise stats 
calculation complete. 

 

7. Click the update button to retrieve and display the results. 

 

8. To calculate with processed images (with NUC and DPR) verify the corresponding boxes in the 
NUC/DPR window are checked. Repeat the calculation and retrieval steps. 
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9. The results are shown in the Noise Stats window. If NUC/DPR has been effective, this set of 
numbers should be lower than the first set. 

 

5.5.1 Interpreting Results 

As described in the paper, the calculations apply to a data cube of dimensions {T, V, H}, where T is the 
number of processed frames, V is the height of the image, and H is the image width. 

All the results except SIGtvh and Noise_temporal are standard deviations of sets of averages.  

The values with 1 subscript (SIGt, SIGv, SIGh) apply to averages over planes in the time, vertical, or 
horizontal direction, respectively. For example, if AVGt[t] is the average pixel value of frame t, then 
SIGt is the standard deviation of the set of all AVGt. 

The values with 2 subscripts (SIGvh, SIGtv, SIGth) apply to 2 dimensional sets of averages of 1 
dimensional lines of pixels in the time, horizontal, or vertical direction. For example, if AVGvh[v,h] is 
the average value of pixels at (v,h) over time, then SIGvh is the standard deviation over all AVGvh. 

The value SIGtvh is the standard deviation over all pixels in the cube. 

The value Noise_temporal is average over all (v,h) of the standard deviation of each pixel over time. 

Table 4: Results Summary 

Result Name Description 

SIGt Standard deviation of average pixel value in each frame. (Iterating across time dimension)   

SIGv Standard deviation of average pixel value in each horizontal plane.  

SIGh Standard deviation of average pixel value in each vertical plane. 

SIGvh Standard deviation of average pixel value over time. 

SIGtv Standard deviation of average pixel value of each row. 

SIGth Standard deviation of average pixel value of each column. 

SIGtvh Standard deviation of all pixel values in the cube. 

Noise_temporal Average of all standard deviations of pixel values over time. 
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6 Troubleshooting 

6.1 Dead Pixel Issues 

In most cases the default values for DPR ensure that dead pixels are detected and replaced. If a dead 
pixel is still visible after performing the DPR process it may require adjusting the Min and Max values in 
the Pixel Offset section of the NUC and DPR configuration window in Panel Plus.  

Example: 

 

Figure 15: DPR Pixel Offset Adjustment 

 

Figure 16: Before and After Min and Max Adjustment 

6.2 Number of Dead Pixels Replaced Per Parameter 

To see the number of dead pixels that are being replaced, click on the Get Dead Pixel Stats button in 
the NUC and DPR window. The window will show the current number of dead pixels being replaced 
and the number of dead pixels per parameter. 

This can be useful when values are adjusted to see if there are any changes or if the change in values 
caused too many pixels to be replaced.  

Continue to reset and recalculate dead pixels by adjusting the Min and Max parameters until the dead 
pixels are removed. 

 

Figure 17: Dead Pixels Replaced 

6.3 Capture Raw Images 

To facilitate additional troubleshooting, generate the following image: 

• 30 snapshots of blackbody source at HOT temperature. 

• 30 snapshots of blackbody source at COLD temperature. 

• PNG snapshots (the more the better) of any scene without calibration applied. SightLine can then 
generate and apply the NUC and DPR to verify the calibration. 

 Send the images along with any other relevant details to SightLine Support. 

Adjust Min and 
Max Values 

Dead pixel 
visible after DPR 

Dead pixel 
removed after 
adjustment 

mailto:support@sightlineapplications.com


 EAN-NUC-and-DPR  

© SightLine Applications, Inc.                                                                  18 

This following process requires the Recording license feature to be enabled. See the EAN-File-
Recording document for additional information regarding file recording. 

1. Prepare camera with a hot calibration target. 

2. Insert microSD card into the OEM. 

3. Power up the OEM, and then connect with Panel Plus. 

4. In Panel Plus select the Record tab. Click the Advanced Settings button. 

5. Configure the snapshot settings as shown. Leave all other settings as default. When complete click 
Send and close the dialog window. 

 

6. Enter a filename for the snapshot. The PNG extension is added automatically. 

 

7. Click Start to capture the image. 

 

 

http://sightlineapplications.com/wp-content/uploads/EAN-File-Recording.pdf
http://sightlineapplications.com/wp-content/uploads/EAN-File-Recording.pdf
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8. Click Refresh List to verify the images were collected.  

 It is not important if all the images were not captured. A sample of images over time is all that is 
necessary. 

 

9. Repeat the procedure with a cold calibration target. 

10. Repeat procedure again pointing the camera at a normal scene, with correction disabled. 

11. Transfer files from microSD card to the PC. 

6.4 Pixel Grey-Level Wrap 

Problem: Very bright regions wrap around to appear as dark regions on 1500 or 3000. 

Solution: Verify that Bit Depth is set to 16 (not 15 or less) in the Acquisition Parameters. 

7 Questions and Additional Support  

For questions and additional support, please contact SightLine Support. Additional support 
documentation and Engineering Application Notes (EANs) can be found on the Documentation page of 
the SightLine Applications website.  

 

 

 

 

 

 

 

mailto:support@sightlineapplications.com
https://sightlineapplications.com/documentation/
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Appendix 

New in 3.01.xx software. 

A1 Adding Dead Pixels Using Command and Control  

1. In Panel Plus open the Send Raw Message dialog window, main menu File » Send Command. 

2. Check Insert Header, Insert Len, and Insert Checksum (Figure A1). 

3. In the dialog window type DeadPixel. Select the DeadPixel drop-down option when it appears. 

4. Fill in the parameters using the IDD. This example designates the pixel at column 1 and row 256. 

 This is a serial command. The lower byte is listed first when a parameter is larger than 1 byte. In this 
example parameter a and b are both two bytes.  

 The parameters for this command are shown in the verbose area in the dialog window. 

5. Click Send. After sending the command the designated dead pixel will be added to the dead pixel 
table.  

 

Figure A1: Adding Dead Pixels Using Command and Control 

6. From the NUC/DPR dialog window, save the DPR table to the microSD card file system. Enter a 
filename in the dead pixel table field. Click Save. Click the Set as Default button to apply the file at 
bootup. 

A2 NUC Table File Structure 

The following format applies to the newest version (Version 1) of the NUC table. Previous versions are 
still readable by current firmware but may vary in structure. The NUC table is written in binary format 
in the following order: 

1. Unsigned 32-bit integer - Table version. 

2. Unsigned 32-bit integer - Magic number (0x51acd00d). 

3. Signed 16-bit integer - Height of table/image. 

4. Signed 16-bit integer - Width of table/image. 

5. Gain and Offset Struct for every pixel. 

6. Gain and offset struct: 

a. Unsigned 16-bit integer - Gain (shifted up by 13). 

b. Signed 16-bit integer - Offset. 

Table A1: NUC Table Versions 

Version  Initial Software Release Description 

1 2.25.xx Initial NUC table 

https://sightlineapplications.com/releases/IDD/current/
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A3 Dead Table File Structure 

The following format applies to the newest version (Version 3) of the dead table. Previous versions are 
still readable by current firmware but may vary in structure. 

The dead table is written in binary format in the following order: 

1. Unsigned 32-bit integer - Table version. 

2. Unsigned 32-bit integer - Magic number (0x51acd00d). 

3. Signed 32-bit integer - Number of dead pixels. 

4. Dead pixel calculation parameters (version 2 and later): 

a. 32-bit floating point number - max gain. 

b. 32-bit floating point number - min gain. 

c. Signed 32-bit integer - max offset. 

d. Signed 32-bit integer - min offset. 

e. Unsigned 16-bit integer - max pixel value. 

f. Unsigned 16-bit integer - min pixel value. 

g. Unsigned 32-bit integer - max standard deviation. 

h. Signed 32-bit integer - max number of dead pixels. 

5. Dead table version 3 and later: 

a. Signed 32-bit integer replacement method. See Command and Control Packet NucParameters. 

b. Unsigned 8-bit integer number of neighboring pixels to use for average/median dead 
replacement. 

6. Dead list structure per pixel: 

a. Unsigned 16-bit integer - row location of pixel (Y-coordinate). 

b. Unsigned 16-bit integer - column location of pixel (X-coordinate). 

c. Signed 8-bit integer - row offset to pixel replacement (Y-coordinate, version 2 and earlier). 

d. Signed 8-bit integer - column offset to pixel replacement (X-coordinate, version 2 and earlier). 

 (0,0) is top left increasing in number to bottom-right. 

 IMPORTANT: The dead list must be placed in ascending order. Row location (Y-coordinate) 
followed by column location (X-coordinate). 

Table A2: Dead Table Versions  

Version  Initial Software Release Description 

1 2.25.xx Initial dead pixel replacement table 

2 3.1.xx Added saving of dead pixel calculation parameters 
(pixel max/min, gain max/min, etc.) 

3 3.3.xx Added average/median replacement. Removed 
offset to pixel replacements in per pixel list 
structure. 
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A4 1-pt NUC Command and Control Example 

The following is an example of using command and control to perform a 1-pt NUC. 

1. In Panel Plus open the Send Raw Message dialog window, main menu File » Send Command. 

2. Check Insert Header, Insert Len, and Insert Checksum (Figure A2).  

3. In the dialog window type NucParameters. Select the NucParameters drop-down option when it 
appears. 

 

Figure A2: 1-pt NUC Command and Control Example 

4. Close shutter or obtain a flat field. 

5. Add a single (1) frame: 

NucParameters <XX>,01,01,<YY>,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00, 
00,00,00,00,00,00,00 

<XX> = camera index (e.g., 00 for cam0) 

<YY> = number of frames in Hex (e.g., 01 for 1 frame) 

 The cameraIndex, numFrames, nucShow, and nucRunMode are the only fields that are used during 
the Add Frames function. The remaining fields can be set to 0x00 since they are not used.  

Adding a single frame will only use the information provided by that frame to adjust the offset 
values. Depending on the situation, this may accomplish the intended outcome.  

IR cameras have a natural noise from frame to frame. To get an accurate result add more than one 
frame (5-10). The 1-Point NUC will use the average of these frames to adjust the offsets.  

6. Perform 1-point NUC: 

NucParameters <XX>,01,07,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00, 
00,00,00,00 

<XX> = camera index (e.g., 02 for cam2) 

 The cameraIndex, nucShow, and nucRunMode are the only fields that are used during the calculate 
1-point correction. The rest of the fields can be set to 0x00 since they are not used. 

After performing a 1-Point NUC the information from the added frames will persist in the system. 
To clear this information, perform a power cycle or click the Clear All button in the Non-Uniformity 
Correction dialog window. If performing a 1-Point NUC again within the same power cycle, these 
frames will continue to average the information as more frames are added. Clear the frames before 
adding more if this information does not need to be included. 
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